ayer Style

Styles

Blending Options: Default

[C1Drop Shadow
[ Inner Shado
Outer Glow
[l Inner Glowe
ClBevel and Ermboss
[ Contaur
[ Texture
[15atin
ClColar Cvelay
Gradient Dverlay
ClPattern Cwetlay
Stroke

Gradient Overlay
Gradient
Elend Mode: | Mormal
Cipacity:
Gradient:

Creating Buttons

Now, onto the good stuff!

In this chapter, we’ll be making navigation buttons.

The solutions I’ll describe are for creating button effects.

Don’t worry about making a complete navigation interface

in Photoshop yet; I'll help you design layout comps later in

the book.

The techniques you’ll learn here can be applied to any

“button-like” object, including icons, bullets, title and

navigation bars, and other page accents.

Style: | Linear

Angle: -(-[} o0

w | [¥] Align with Layer

L]

Srale: 3 100 |%a
o) )
Q ﬁ @ - =
\ T / Layers  Ghanmels 4Baths v
#8e8e96 #fofeff #9d9dal1 #¢ momal w [Opacity: | 1009 | »
Lock: [ =+ & Fill:| 1009 | #
e
= ! 8 highlight & =
@ Effects
@Outer Gl
FinEs Gl
& Gradient Overlay
= T |button text 7

o Wi o
!Ehuttun ] i
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Making a Simple, Flat Button

Solution
Rectangular Flat Button

We’re going to draw a basic, rectangular button. Set the foreground color to a color of

your choice, then draw a rectangle with the Rectangle Tool (U).

I told you it was basic! I've made mine more TR o am———
edtors sl ittt it 1| b' A o H

interesting by drawing another rectangle in a

lighter color to give my button a thick border

on its left-hand side, as shown at right.
== 9.0 &0 & 3.

A rectangular button with a thick border

Rounded Flat Button ’
You can also create basic, \@-| @ weDaln e | g sve N - coo: [l
rectangular buttons with - BT Ty =) | e— — ==
rounded corners using— W% - e

G o
you guessed it—the Rounded &4, Eé@?'ﬁ“f‘“

2, 5 Foe — e :
Rectangle Tool (U). Alter the @&, ol

0.8
“roundness” of your corners KT, =eoo6ogsl

. . . )

using the Radius field in the )

options bar, as shown here.

Rounded rectangular button with a ten-pixel radius

NOTE Photoshop Doesn’t

k. T, Radlius: (ﬂlhil'l P ey ‘ @ Style: 'E
Replace CSS N —
“ 5| S LEE
O a

On a web page, you'd probably use
CSS instead of images to achieve this
rectangular button effect. However,
this technique is handy when it
comes to drawing simple buttons for
web comps in Photoshop.

n’ | | CGED

B |

Rounded rectangular button with 20-pixel radius

Adding an Qutline to a Button G

In this solution, we’re going to be adding outlines

to our basic buttons to make them look like the _

ones shown here.

Buttons with outlines
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NOTE Adding Layer Styles

In this chapter and beyond, we'll be making heavy use
of layer styles, which are applied by launching the Layer

Style window. There are a few different ways to launch this [T ayers Chamnas L pathe g[?jf T e — o)
window, but the one | use most often is to click on the little f I'_N:k”’;] P ;%.] OP‘;::;_::]:_I: I% v ?;::rss'::;;\ ::
button at the bottom of the layer palette, as shown here. CE =l gl Ionf:rr;? E
Clicking this button will display a dialog box listing all of r; P | chea
the different layer styles available. Simply choose the one _g r g'_;mm‘ ve S\s g:‘:d’lig':;m

you want and the Layer Style window will launch, with the ® | oo E J; Z:::;?w'a‘f---

specific effect selected. It's also possible to select the same 7&:.? /T e

styles from the menu bar (Layer > Layer Style), but using
the icon saves you one mouse click!

Adding a layer style

Solution
Let’s add outlines to the Layer Style
. — Strok
basic buttons we created Uk -
Blending Options: Default S T
i ()] Shac Sieei L |
earlier. Select the layer that R N —
contains your button. Open Couter Gow e e i
[DInner Glow Opacity: a| 100 %

the Layer Style dialog box by

[OBevel and Emboss
[ Canitour

u

clicking on the Add a layer [Texture color: I
[]5atin
style button at the bottom Dcolr Ovetlay

[ Gradient Owerlay
[CIPattern Overlay
[Estroke

of the Layers palette and
selecting Stroke... from the

menu that appears. You’ll
see that the Stroke style is
checked and highlighted—
this adds the outline to your button. Change the look of your stroke by adjusting the

Adding an outline to a button by changing its stroke options

settings. You can see from the dialog shown above that I gave mine a black outline
by clicking on the color patch and setting the color to black, and gave it a thickness
of one pixel by typing 1 into the Size field (you could also use the slider to adjust the

size of the stroke).

Making a Smooth,
Beveled Button

They’re getting fancier! Let’s have a go at creating the

beveled buttons shown here. Smooth, beveled buttons
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Solution

By now, you should be an expert in creating basic, rectangular buttons. Just as well,
because you’ll need one for this solution! Create or select your basic button. Open
the Layer Style dialog box by clicking on the Add a layer style button at the bottom

of the Layers palette and selecting Bevel and Emboss... from the menu that appears.
You've just added a bevel to your button. You can give the bevel a more rounded
appearance by increasing the Size and Soften levels. I'm using 7px for Size and 8px for

Soften, as shown in the image below.

Make the effect more subtle by changing the Shadow Mode color. Since my button is
blue, I've changed the Shadow Mode color from black to blue (a slightly darker shade

than my button color).

Layer Style ﬁ
Styles — Bevel and Emboss ————————————————
— Structure

Elending Options: Default .
[JJDrop Shadow: Style: __
Clinner Shadow Techrique:
] Outer Glow Deptt: 03— ‘muj% [“lPreview
Cirner Glow Direction: @uUp O Down

[ Cortour Soften: —————— @ |px

[ Texture N S—
[Isatin — Shading p—
[ color Overlay Angle: 12UD g‘ -

s Global L

[ Gradient Overlay o | 3r_ Te

CPattern Ovetlay

[strake Gloss Contour: Ijzl [ anti-aliased

Opacity: a— \_75_5%
Shadow Mode: | Multiply |V -
Opacity: — \7775 %

Bevel and Emboss options for smooth bevel

Creating a Chiseled Button Effect

The Bevel and Emboss layer style is a

versatile tool that can be used to create

many different button effects. In this _

Chiseled buttons

solution, we’ll use it to create hard-edged,

chiseled buttons like the ones shown here.

Solution

Create or select a basic button. Then, open the Layer Style dialog box by clicking on
the Add a layer style button at the bottom of the Layers palette and selecting Bevel and


http://www.sitepoint.com/launch/650367/

The Photoshop Anthology

Emboss... from the menu that appears. From the Technique drop-down menu, select
Chisel Hard and set the Soften field to Opx. Increase the Depth of the bevel to chisel

“deeper” into the button.

Layer Style )
s Fhdibne
— Structure
Blending Options: Default s Bevel |v
Style: | Inner Bevel
[IDrop Shadow: e [— News Sty
CInner Shadow Gl Gt No— .
C0uter Glow DB — | &51] % el
Elirer Eiov Direction: @ Up (O Down
“IBevel and Embos Sz O [6 -
[ Contaur Softemy—————— | u] pr
O Texture - 50
— Shadin
[ Satin Y L,
[ Color Crerlay Anle: |20
O Gradient Owetlay -Uigﬂhal Light
Altitude: a0

[CPatkern Overlay —
CStroke Gloss Cantaur: |]Z| [ anti-aliased

Highlight Mode; | Screen ‘V I:l

Oparity: a— I?S %
Shadow Mode: | Multiply “’ -
Opacity: o — |7757 %%

Bevel and Emboss options for chiseled bevel

Creating an Embedded Button Effect
In this solution, I'll show you a button effect that

makes your buttons look like they’re embedded

. ! e ———
into the page, as shown here. -

Embedded buttons

Solution

Select or create a basic button. Open the Layer Style dialog box by clicking on the Add
a layer style button at the bottom of the Layers palette and selecting Bevel and Emboss...
from the menu that appears. From the Style drop-down menu, select Pillow Emboss—

this will give your button an “embedded” effect.

Experiment with the settings to change the look of your effect. Both the buttons in
the example shown above are pillow embossed, but they look different because I've
set the Technique to Smooth for the top one, the settings for which are shown on the
next page, and Chisel Hard for the bottom one.
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Layer Style
Styles —Beveland Emboss —————————————— =
— Structure ok ]
Blending Options: Default e
[ Drop Shaclow Style: | Filow Emboss | __
[ 1nner Shadow Technique: | Smooth |v Wew Styls. ..
[ outer Glow Depth: "{gu_}% [ Preview
[CInner Glow Direction: @up O Down
[-]Bevel and Emboss. St ———— |8 ?DK
[ Corttour Softer: —— 33— \S_'DX
O Texture e
— Shadin
[Jsatin g

[ Color Overlay Angle: |120 |
V]
[ Gradient Qverlay ) 2 Global Light
Altitude: El
[IPattern Overlay | |

Ostrake Gloss Contour: Ijzl Clanti-aliasad

Opacity: a— \75 E%
Shadow Mode: | Multiply |" -
Opacity: o ]_7-5 2%

Pillow Emboss options for the smooth embedded button

Making a Gradient Button

#1f71ce
Two-toned gradient buttons like the ones _
shown here are the “new black” of graphic

#6db7e6

design. This effect has become increasingly
popular—no doubt you’ll have seen it used eTce
on the buttons, menu rows, and heading

backgrounds of trendy web sites. In this —
solution, I'll show you how easy it is to #333399

create your very own gradient buttons.

Examples of gradient buttons

Solution
Raster Buttons
Using a selection tool, such as the Htntited 17 100" OB | 1 ayers e o
| Hormal [ |opacity: | 100% [»
Marquee Tool (M), create a _ Lok @ Ak 1005
rectangular selection for your \E E@uﬁm ‘:.
! Backgraund
button. Set the foreground and [ 100% [
background colors to the two
= 60® 0 4 8

tones you want in your gradient,
and create a new layer. With the Locking transparent pixels

Gradient Tool (G) selected, choose the Foreground to Background gradient option and
click and drag the mouse to fill in your selection. (Holding down Shift will constrain

the gradient direction to a horizontal or vertical line.)
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WARNING Useful, but not Terribly Usable!

For all its power, the Layer Style dialog is
amazingly unintuitive. What | find most
confusing is the fact that you can apply a style
without selecting it!

That's right—once you've launched the Layer
Style dialog, you can apply a style (with
Photoshop's default settings) by checking its
checkbox. If you have the Preview checkbox
ticked, you'll see the effect this style has on your
image. Fairly straightforward, right? But what's
confusing is that this doesn't actually select the
style, so you can't change its settings! You need
to highlight the name of the style to bring these
up—simply checking the checkbox won't do!

The example shown here demonstrates this: In
the top image I've checked the Drop Shadow
style, which has been applied, but the settings

in the dialog box are for the layer's Blending
Options. This means | can't make any changes to
my drop shadow!

If | click on the name of the layer style instead,
my drop shadow is applied and its settings are
displayed (as shown in the second image). Because
of this, you might think that if | click on the name
of another style that I've applied, it will be turned
off in the document. That's not the case—you'll
have to uncheck the checkbox for that!

[] outer Glow

[ tnn=r Glow
[ Bevel and Emboss

— Blending Options 0K
— General Blending
B o
Opacity: W %
2| Mew Style...
— Advanced Blending Preview
Eill Opacity: Q00 |%

Channels: ¥R [¥]e [V]s
et

[[]Blend 1nterior Effects &= Group

-

[JCentour. [] Bland Clippad Layars 2= Group
E [¥]Transparency Shapes Layer
: [[JLayer Mask Hides Eff=cts
[ sstin [ Vector Mask Hides Effects
[ Color Overlzy
—  Blend 1 [Grav [+]
[ Gradient Overlzy
Thislaysr: 0 255
[ Pttern Overizy s ]
[ stroke o 2
Underlying Layer: @ 255
1
Fy o
Applying a Layer Style
Layer Style N
— Drop Shadow
E QK
yles — Structure ¢ )
Blending Optiors: Gustom send pioce: [muict [ I[N
Ecereres P 3 =
[@Drop Shadow s = ) New Style...
el Angle: ®Liihij" [#]use Giobal Light Preview
[ outer Glow
e s |
[ Inn=r Glow = (S

[ Beve! and Emboss
[] contour
[ Texture
[] satin
[ Calar Dverizy
[] Gradiant Overiay
[ Pattern Qwerizy
Stroke

Spreadi ) [c o

————

— Quality

Contour: [] anti-zliased

Mot} [g %

Lsyer Krocks Out Drop Shadow

[u]

Selecting (and applying) a layer style

I'd suggest you spend a minute selecting and applying a few different layer styles until you get the hang of how it all

works—it'll save you from confusion later on!

We can achieve the same gradient button effect using the Lock Transparent Pixels

option that’s provided for layers. This option is useful for rounded rectangles or

other shapes for which we’re not provided with automatic selection tools.

Let’s use it to make a rounded rectangle button. Using the Rounded Rectangle Tool (U)

with the Fill Pixels option selected, create a sold-colored, raster button on a new layer.

Click the Lock Transparent Pixels icon in the Layers palette, as shown in the example

above. Then, set the foreground and background colors to your gradient tones and

apply the gradient. Since you’'ve locked the transparent pixels, the gradient will be

applied only to non-transparent elements in the layer: your button, in this case.
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If you’re not happy Layer Style
making raster buttons, Styes et '
radien
Blending Options: Default e __
you can create vector ;;r;';gshzdff = Blend More: | Norml ™ e
[CInner Shadow: Spacty 3e | B
shapes and apply the S e Fliovarsa I preyiew
gradient effect to them Ci o o T
! [eevel and Emboss Angle: @ a0 ® -
Open the Layer Style Dlcantour :
e Scale: - & - 100 %
dialog box by clicking Clsatin
[ Color Overlay
on the Add a layer style T
button at the bottom [Pateam Qe
[Cstroke
of the Layers palette and
selecting Gradient Overlay... Gradient Overlay options
from the menu that appears.
The gradient overlay options will be displayed.
Adjust your gradient by clicking on the Gradient Editor B
Gradient patch in the Layer Style dialog L 2
box. This will bring up another dialog box, -
Load...
the Gradient Editor, shown here, which you
can use to set your gradient options. The
[Marme: .Custnm MNew

colors of your gradient are represented

in tiny color patches underneath the
gradient bar. Double-click on them to
bring up the Color Picker—you can use this
to change the color of the patch (and
consequently, your gradient). Add more
colors by clicking anywhere along the
bottom of the gradient bar—a new color

patch will be placed there.

Click OK in both dialog boxes, and voila!
You'’ve got your two-toned gradient button.
And because we’ve “overlaid” our gradient
onto our button, the original color of the

button is inconsequential!

craient Tyet | Said |v|

4]
=

pothness: | 100 |_>! %

QY

0ps

&

The Gradient Editor dialog

Untitled-2 o 100% (v... (= J[3JEF

(S]]

Lavers @hannels \Paths S 7 )|

100% |0

| Narmal [ [opacity: | 100% [+ |
Lock: [ & < @ Fil:| 1007 [» |
:‘9‘ B == vector @ -
® Effacts
@ Gradient Overlay
[ — - s 5]

Vector button with

= .0 ® 0 &l =

Gradient Overlay

Order the print version of this book to get all 286 pages!
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Making a Round Push-button

In this solution, we’ll call on the trusty gradient button-creating

skills we learned in the solution “Making a Gradient Button” to

make a round push-button like the one shown here.
Round push-button

Solution

1 Create a circular gradient button on a new layer.

2 On another layer, create a circular _ 1‘3 e m——
gradient button that’s a bit smaller than L ”LND:(rlni , Iﬂoaad:ilLD:&u
the first. The direction of the gradient o ;%13. I'
on this button should be the opposite ) - @w -
to that of the first button—in this 2o M - D"‘ o -
example, my big circle has a white-to- = % 0 6 o 3 5.

gray diagonal gradient and my small Creating two circular gradient buttons
circle has a dark-to-light diagonal gradient.

(Don’t be too concerned about lining the shapes up just yet.)

3 Select the layer for the smaller circle

[ =0
i Layers Wﬁm _4fio]
from the Layers palette. Hold down Lrome (e o
. e Lock: [ & + @ Fill:
Ctrl (Command on a Mac) and click o .

ﬁ push-button.p...

¢ Joman a
100% | 0] > @ i 2
& |:| Background 2

the pixels of that layer, as I've done = 60065 5 i
here. (We talked about this in

Chapter 1, remember?)

on the layer thumbnail for the larger

circle to create a selection based on

Creating a selection

4 After you've created the selection, select arange » |
Align ’mw P T TopEdges

= " = vertical Centers

Bottom Edges

Layer > Align Layers To Selection > Vertical

Centers as shown here. This will

|2 Left Edges

vertically align the center of the small scectLinked Loyers n%l Horizontal Centers
Right Edges

circle with the center of the larger one. gl el Sifirsdes
Flatten Image

5 Finally, select Layer > Align Layers To

Selection > Horizontal Centers, and just as

you suspected, the centers of both circles Aligning vertical centers

will align horizontally.

Your push-button is complete!
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Making a Metallic Button with a Matte Finish

More buttons that use gradients! Just as well we

brushed up on our gradient button-making skills in
“Making a Gradient Button”. We’re going to make

matte-finish metallic buttons like the ones shown here.

S()Iutl()n Matte-finish metallic buttons
Rectangular, Matte-finish, Metallic Button

1 First, create a simple raster gradient button. I'm

#a7acaf
going to use two different shades of gray for mine. _
2 Lock the layer by clicking on the Lock Transparent 4707578

Pixels icon at the top of the Layers palette. Select

a light gray (I've used #ebeef0) and use the Pencil Creating 2 grayscale gradient button
Tool (B) to draw left-hand and top borders on the rectangle button layer.

3 Select a dark gray (I've used #515a60) and draw bottom and right-hand borders
onto the button layer, as shown in the example below. Remember to keep your

lines straight by holding down Shift as you’re drawing them.

=
T Layers “Ghannels MPaths % )
| [ [Opadty: | 100% >
/ Loick: |§\|j’3{» a Fill:
| — 1

#ebeefO

-

i

@515&60 i
#ebeefd GI'Iﬂ
B -

=606 0 & 3.

#515a60

I

Drawing borders

4 Sure, we could use the button as is, but I'd like \dd Noise =]
to do a few more things to it. First, we're going T

to apply a noise filter to our button. Before we | -
do this, make sure that you're happy with the

size, shape, and color of the button, as it’s hard
to make changes to these properties after the
filter has been applied. To add the matte finish,

select Filter > Noise > Add Noise. This will give the

& 100%

Amount: i_2_| %

button a grainy look and display the Add Noise O
dialog box. Be sure to check the Monochromatic (gg:gf;;“ﬂ
checkbox, and adjust the amount of noise that MlMonorhromatic
you want to introduce. I've set mine to 2%.
Adding noise
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5 If you feel that the grainy effect is too pronounced, select Edit > Fade Add Noise
to drop it back a bit. Change the opacity of the fade (in the example below, I set
mine to 50%) and click OK.

Fade &4
I
oy Em NOTE Use Fade Promptly!
i 2
Miode: lereve To use the Fade command on a filter,

you'll need to do so immediately
after the filter has been applied—
otherwise it won't be available.

Fading the noise effect

6 Let’s look at our button now. It’s certainly

something we could use, but while we’re
on a roll. let’s jazz it up a bit more Rectangular matte metallic button
’

with some lighting effects.

Select Filter > Render > Lighting Effects a8
Lighting Effects to bring u ok Bl [ o)
g .g_ g P Delete ‘ =
the Lighting Effects dialog L [
1 [#]0n
box, shown to the right. Select e e " D
Spotlight from the Light type Foos  Namow B3 wide
~ Properties,
dI‘Op-dOWn menu. Gloss  Matts 0 Shiny
Material, Flastic &3 Metallic D
Exposure; Under 0 Over
Ambisnce: Negative g Puositive
i~ Texture Channel:
‘wihite iz high
Bieve Q i Height: Flat 50 tountainous

In the preview graphic, you’ll
see an ellipse with a line
through it—this line indicates
the direction of the light. Click
on the direction handle at the
end of the line and drag it to
the upper left-hand corner of
the preview window. You can
then click and drag the handles
on the ellipse outwards to

increase the “spotlight” area, as

shown to the right.

Changing the direction of the spotlight

Lighting Effects

(%]

i

ok ]

Delete

FME Default ¥ 7‘

Cancel

- Light type: | Spaotlight |v =

(]9

On

Intensity Negative 35 Ful D
Focys:  Narow 63 'wide
~ Properties:

Gloss: Matte 1] Shiny

M aterial lic E3 Metalic
Exposure: Inder 0 Over
Ambienge; [Negative g Positive

White iz high

Previsw Q

Heighe Pt 50

1~ Texhure Channel:

tountainaus

m

Applying the lighting effect
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8 Finally, drag the Gloss property slider towards its Matte side (shown at the bottom

of the previous page). When you're satisfied with your button preview, click OK.
Now we’re happy! Our finished button is shown below.
Our pride and joy

Rounded, Matte-finish Metallic Button

Creating a rounded matte-finish button is pretty much the same as creating a rectangular
one. The main difference is that we’re going to use a stroke layer effect to add the

borders, since it’s going to be difficult for us to draw the borders accurately by hand.

1 Create a rounded gradient button. I used the same #a7acaf
shades of gray I used for the rectangular button —
in the previous solution. #707578
Laer Style = Rounded gradient button
Blending Options: Dafault y m
[ltrop Shadow s i - . .
Qs Sk 2 Now, instead of drawing
[ Outer Giow
L . a border as we did for the
S rectangular button, open the
O%atn
Cicor O Layer Style dialog box for Stroke
[ Graxont Crvrky.

and give your border the settings

shown here:

B Size: Tpx

B Position: Inside
Stroke layer style settings | Opacity: 75%

3 Change the Fill Type to Gradient. Click on the Gradient swatch and set the gradient
colors to white (#{fffff) and a darker gray (#384046). As the opacity of the stroke
is lowered, you’ll want more contrast between the light and dark colors. (If you're
wondering why you need to lower the opacity, it’s so that the noise and lighting
effects will show through.)

4 Adjust the Angle so that most of the gradient stroke HEFEEFF
is at a slight angle in relation to the button. ‘ .

5 Click OK to apply the stroke effect. The example

at right shows the result of our stroke.

Applying the stroke effect to the button
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6 Now, add noise and apply a lighting effect
(steps 4-8 in the Rectangular, Matte-finish

Metallic Button solution), and your rounded

button is complete! Completed rounded matte-finish metallic button

Making a Shiny Metallic Button

Here, I'm going to show you how to create shiny, —_— —
metallic buttons like the ones shown to the right. ¢ ) € ) | ]

I'll also show you how you can vary their . B \ [ ,

appearance using different settings.
Shiny metallic buttons

Solution
1 Create a raster or vector button. I've created both — _

a rounded and rectangular button in this example. Bacic buttons
The color of the button is unimportant, as it won’t
affect the final result.

2 The fun begins! Open the Layer Style dialog box by clicking on the Add a layer style
button at the bottom of the Layers palette and selecting Outer Glow from the menu
that appears. In the dialog box, change the Blend Mode to Normal, and click on the

color swatch (light yellow by default) and change it to gray, as shown here.

Layer Style
o outer dlow
[~ Structure
Blending Options: Default
Blend oce:
[CDrop Shadow
L T

[CInner Shadow

ol F Moiser 3 |07 Yo

Dier Gow om

[1Bavel and Embioss
[ Contour

[l Preview

-

— Elements

O Texture Lz
[5atin Spread >———————— |0 %
[lcolor Overlay sre: J——— |5 |
[ Gradient Cwerlay — Quality
ClPattern Overlay
Cstroke el m [ anti-aliased

(=0 %
Jtter: 3 |0 (%

Range: -

Applying outer glow
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3 Now, select Stroke from the styles — Stroke
— Structure
list in the dialog box to add a - 1 |
stroke layer effect. I used a dark position: | Outside ||
Blend Mode: | Mormal

gray, 1px stroke, as shown here. _ R
Opacity: 7_‘“@ ;%

4 We’ dy to add the gradient
ereready toa e gradien ~ Fil Type:
overlay (there go those gradients Color: [

again!). Select Gradient Overlay
from the Styles list in the dialog
box, and double-click on the

gradient color swatch to open
the Gradient Editor dialog box. Set the Applying a stroke to the button

colors of the gradient as I've done overleaf.

Add more color patches to the gradient bar by clicking anywhere along the bottom
of it. Edit the color of a patch by double-clicking on it to bring up the Color Picker.

You can also click and slide color patches to adjust the appearance of your gradient.

Layer Style &
Styles — Gradient Overlay [T
— Gradient
Blending Options; Default Pt .
L b
[C10rop Shadow BRI HIOOE, m -
Opadity: - « J 100 % MNews Style,.,
[CIInner Shadow ! ——
4] Outer Glow Gradient; E b -] [Reverse bl
[CIInner Glow Style: [#] aligr with Layver
[IBevel and Ernboss Argle: :'90 e D
[ Cortaur T
[ Texture Scale: —— [100 %
CISatin
[CColor Ovetlay l; E
iodent ey K i
[CPattern Overlay
Stroke ? “ﬁ
#8e8e96 #f5f6ff #9d9da1 #c6c8d5

Adding the gradient overlay

5 Click OK to apply all the layer styles.
Your shiny, metallic button is complete! Turn —_— — —
off the Stroke style for a more subtle effect
(uncheck its checkbox to do so)—I did this for

the left button in the examples shown here.

Completed shiny, metallic buttons

Variations
You can vary the appearance of your shiny button by playing with the gradient editor
settings. The examples below show how the look of our shiny button changed when

different gradient configurations were applied.
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( ) ¢ ) [ | - I ) | *
T T — 2
h—4 P~
1 /
#5f5f6c #9d9dal #eae9f3 #c6c9d5 #ffffff #b7b8c4 #ffffff #aaadb9 #ffffff #8e909e
Variation 1 Variation 2

Applying different gradient configurations to buttons

Making an Aqua Button P
In this solution, I'll show you how to make the brightly colored, ﬁ

glassy buttons that originated from Apple’s Aqua interface
many years ago, and since then have come to be affectionately Examples of aqua buttons

known as “aqua buttons.”

As we're talking about buttons in this chapter, I'll show you how to create the button
effect here, but if you’ve taken a particular liking to the brushed metal background I've

used in this chapter, don’t worry—we’ll learn how to create that in the next chapter!

Solution

1 Start with a rounded vector button. We're going to be adding a gradient overlay to
it, so its color’s unimportant—use any color you like! The first step is to apply a
gradient overlay to our button. Open the Layer Style dialog box by clicking on the
Add a layer style button at the bottom of the Layers palette and selecting Gradient

Overlay from the menu that appears.

Layer Style B
Styles — Gradient Dverlay
— Gradient

Elending Options; Default
[1Drop Shadow: Bled Haee: ._ - __I
Cinner Shadow Cpacity, —— 0 108 |% L St\fe"'
Clouter Glow » Graclient; [T -] [IReverse Mlprevew
Clinner Glow Style: [ align with Layer
[IBevel and Erboss » S @ oo | .

[ Cartour —1

[ Texture Scale: a0 (%
[C5atin
[ItCalor Owerlay
“IGradient Dverlay
Ij Pattern Overlay
[Cstroke

Applying a gradient overlay to the button

2 In the dialog box, set the angle to 90° (shown above) and click on the Gradient
patch to display another dialog box for the Gradient Editor, shown opposite.
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Gradient Editor =<
— Presets »— o
A7
Name: E-(Eu_s&m \ [ New ]
[~ Gradient Type: | Solid v
Smoothness: | 100 | | %
—Stops
Oacity: o Location | :"Ju Delete
CU|UF:-E Logation: | 25 % Delate

Changing the gradient settings

3 Let’s change our gradient settings using the Gradient Editor. Double-click on
each of the tiny color patches below the gradient bar to change its color. Create
an aqua-to-blue gradient by setting the color of the patch on the left to aqua
(#3cc9e2), and the color of the patch on the right to blue (#1160c2). Set the
Location of the aqua patch to 25%, and click OK to apply the gradient.

4 Back in the Layer Style dialog box, click on Inner Glow. Set the Blend Mode to
Normal, the Opacity to 50%, and the Size to about 10px, depending on the size
of your button. Click on the color patch and change the color to a dark blue, as

shown in the example below—I've used #003298.

Layer Style %]
Styles — Inner Glow F % g
— Structure
Blending Options: Default i |
; __.v
[CDrop Shadow o e 0 b o e
. : o .
Cinner Shadow Onacity: 3 \5:, fo« .
Cout Moise: 3 10 £ Preview
Flinner Glow. #@l O W .
[ClBevel and Emboss
— Elements
[ Cortour 3
O Texture Technique:
[C]5atin Source: O Center (D Edge .
[ olor Cverlay Choke: 3 o %o «
[ Gradient Crverlay Sie: 3 10 mx
[JPattern Overlay — Quality Result
Contour: [ anti-aliased
Range: Y = |%
Jitter: 3 "0 E%

Applying an Inner Glow layer style
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5 Next, we’ll apply a slight glowing effect. Click on Outer Glow. Change the Blend
Mode to Normal, the Opacity to 50%, the Spread to 4%, and the Size to 5px (you

might need to tweak these settings to suit the size of your button). Change the

color patch to a bright aqua color, as shown below—I've used #00bae8.

[Ccolor Cverlay Seet d——— |5 71[3)(«

Layer Style B
Stys e Dl ST
. Structure
Blending Options: Default
S
[10rop Shadow: Sals e o3 e o=
Opaity: 3 Hew: Style..,
Cinner Shadow =
T e Moise: ] [0 % Preview
Elirner Glaw I*G e
[eevel and Emboss .
— Elements
Clcontour 3
[ Texture Techrique: .
: E——T
[5atin Spread L‘%

Result

Gradient COverlay

— Quality
[CPattern Overlay
[Cstroke Corttour: m [ anti-aliased
Range: - O [0 %

Jteid——— (0 %

Applying the Outer Glow layer style

6 Click OK to apply all the styles.

7 To create the button highlight, duplicate the button
layer by pressing Ctrl-J in the Layers palette
(Command-J on a Mac). Turn off the Outer Glow and
Inner Glow styles for this layer by clicking on their
corresponding eye icons, as shown at right.

8 Double-click on the Gradient Overlay style name in
the Layers palette. The Layer Style dialog box will
appear, with Gradient Overlay selected. Click on
the Gradient patch to bring up the Gradient Editor.

Layer Style
Siyles Gradient Overlay
Gradient
Blending Options: Default
Blend Mode; | M | i%
[1Crop Shadow e Ll—,.!_.__
Opacity: ——————— 3100 %

|

[IInner Shadow

=]
1 Layers “Channels MPaths™. 7 &)
| rormal [ |opacity: | 100% [ » |
|
!Lock: Ut a Fill: | 1009 |
I —
- B
o
@ Effects
| Ouiter Gl
Etkner Glow
| ® Gradient Overlay

!ls button text @~ |
!|9 ! ] = button 2 'M
| = g

®©. o 3 #@ [

Turning off the layer styles of the highlight

=
B

[__ Cancel |

[ Mew Style... |

[CICuter Glaw Gradient: [Creverse | [“IPreview
[Clinner Glow Style: | Linear lick to edit the gradient pyer

[IBevel and Emboss Angle: mrgbﬁﬂ

[ Contaur et

O Texture Siale: J 100 %
[1Satin
[ Color Crverlay

[“] Gradient Ovetlay
[Pattern Overlay
[I5troke

Editing the gradient
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9 Double-click on the color patches Gradient Edtor L&
underneath the gradient bar in the i)
: .
Gradient Editor and set them both to
white.
10 Click on the patch above and on the — i ;
Mame:  Customn ey
left-hand side of the gradient bar— e
this is the left opacity stop. Set its o EEM
< @
Opacity field to 0%, as shown at right. ﬁ}@ \
. . . . a] a
11 Click OK to exit the Gradient Editor, s A
and again to apply the new style. o g L
Color; l:lEl cation: |_‘ L Delete

Step 10: Creating a white-to-transparent gradient

12 In the Layers palette, change the Wequbatoniped - OEd
fill for the shape to 0%. This will

allow the button on the bottom

Q x
U Layers ~channels SRaths ™0 )
| riormal [+ |opacity: | 100% [» |

Lock: O w#+ @ Fill: | 10004

layer to show through, as shown

 Outer Glow
100% | &) : Inner Glow

at right.
13 With the highlight layer selected,
open Edit > Free Transform or press |®aquabuttont psd - 2G|

Ctrl-T (Command-T on a Mac). :

A bounding box will appear O[> om s __1\57
around the highlight. Click on ® v L3 aua on white

the bottom edge of the bounding |, = | 1o I [F] wahion o2-
box, and drag it upwards to e
squash the highlight a little bit.

Q s
[ Layers ~Channels paths 5007 (1)
| Mormal [ |onpacity: | 100% » |
Lock: O 4+ @ Fl\l|n,{ :

Step 12: Changing the fill of the highlight layer

14 Next, click on the right- and left-hand sides

of the bounding box, and drag the edges of ‘ e A )

the highlight until they are just inside the

button layer. Your highlight layer should look . o
something like the one shown in the graphic Step 14:Transforming the highlight layer
at right. Apply the transformation by double-clicking inside the box, or pressing

Enter (Return on a Mac.)
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15 Switch to the Direct Selection Tool (A). Click and drag the bottom edge of the
highlight path upwards to flatten it, as shown below. Use Ctrl-+ (Command-+ on a

Mac) to zoom in if you need to.

Changing the shape of the highlight

16 We're finally ready to add the text! Create a text layer in between the highlight

and button layer and type in your text. I've used a dark blue color for mine. I've

also added a subtle drop-shadow style to my text using the settings shown in the

example below.

Layer Style &
Styles PR W
i Structure
Blending Options: Default
iDrop Shadow. Elend Mode; | Multiphy -
R ELE Oparity: . 3 g7 e Hewr Style..
[Cinner Shadow: SIE el e
Clouter Glow Angle: @ :50__i° [¥]use Global Light -
[lInner Glow Bt | 1
istance: ——— |2 )
[CBevel and Emboss = f"_?p « .
read: |
[ Contaur S !_D._!%
[ Texture Ske: 3 |3 «
LISatin — Quality Result
[CIColor Overlay
[CIPattern Overlay Moise: 35— 0 %
[15troke =

[#]Laver Knocks Out Drop Shadaw

Applying a drop shadow to text

17 At this point, we’ve got a snazzy aqua
button that will work well on most web

sites, but since we’ve made a habit of

S|

I Layers “Ghannels \paths S0 )

|| Mormal w |Opacity: | 100% > |

taking things those few steps further, why
stop now? Let’s make our button look like
it’s been embedded into the page. Duplicate
the button layer and drag it to the top,
above the other layers. Let’s call this top

Lok (] s @ Fill:| 100%

—— i 1 [~

] @!g 58 QH 1

& ! @ ! highlight & 7 =
|

= button text e
T

] ! 7] ! button @

layer emboss; your Layers palette should

= §. 0 ® 0 & F |

now look like the image shown at right.

Duplicating the button layer
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18 Hide all the layer styles on our
emboss layer by clicking their
respective eye icons in the Layers
palette. Open the Layer Style dialog
box by clicking on the Add a layer
style button at the bottom of the
Layers palette and selecting Bevel
and Emboss... from the menu that
appears. Select Pillow Emboss from
the Style drop-down menu and
change the technique to Chisel
Hard. Set the Size to 2px and the
Angle to 90°.

19 Towards the bottom of the dialog box you’ll see
opacity fields for Highlight Mode and Shadow Mode.

Set these both to 93%.

20 Finally, apply a stroke to the edge of the button.
You should be familiar with this by now! Select
Stroke from the Layer Style dialog box and give
your button a Tpx black stroke with 60% opacity,

as shown in the dialog at right.

21 Click OK to apply the layer styles.

Creating Buttons

Layer Style 4
yer Sty
Styles — Bevel and Emboss "
Structure
Blending Options: Custom —_—
[Drop Shaclow sl -ii
5 MNew Style...
[nner Shacow Technique: l by &
I Outer Glow Depth: -3 - 100 |% preyiew
ClInner Glow Direction: @uUp O Down
[“IBevel and Emboss Ske: I 2 «
[ Contour Soften: ¥ i} (o3
[ Tesxture e~
- Shadin
[ Satin d
[CIcolor Overlay

[ Gradient Cverlay
[1Pattern Overlay
[stroke

Angle: an “*
[Cuse Global Light
a7 =

Altituce:

Gloss Contour: |
|

Highlight Maode: iEE’E?'Ii : 1
Opacity:

Shadow Mode: | Multinly I;i-

Opacity: -~ 3 (93 |% «

Applying the Bevel and Emboss style

Stroke
Structure

Sze: i

Position: | Outside 7\;75

Blend Mode: 7NUrmaI \Vi
Opacity: & g0 (%
[ Al Type: [ color ':E
Color: [

Adding a Stroke layer effect

22 Let’s change the Fill of the emboss layer to 0%, as

shown at left, so that the button layer beneath it can

. =]
| Lavers “Channels WPaths S Y o)
| Marmal [ |Opacity: | 100% [+ |
Lock: O] & b @ FiII:[Tﬂ ]
: == ol
= .@!embuss L
| i
& Effects E
Outer Glow L
Irner Glow

@ Bevel and Emboss
Gradient Overlay
® Stroke [oel

Changing the fill of the emboss layer

Discussion

show through.
Our embedded aqua button

is complete! The image at right

shows our normal and

embedded aqua buttons.

Completed aqua buttons

Since we created this aqua button using vector shapes and layer styles, we have a

scalable button that’s easy to edit. If we want to change its colors, all we have to do is

change the colors of the gradients and effects in our layer styles. If we want our button

to be slightly longer, we can use the Direct Selection Tool (4) to modify the vector path.

Order the print version of this book to get all 286 pages!



http://www.sitepoint.com/launch/650367/

The Photoshop Anthology

This solution has demonstrated an important concept about layers: even when the
fill of a layer is set to 0%, the layer styles still show up! You may find this useful

when you’re creating your own effects.

Another cool thing about this oo E%
technique is the fact that once you've | & aawbuttont.psd . [ [DIEJ | [noms agjopasty:| oo o]

[l | Lock: L1 4 @ Fill:[ 100% [ » |
created your first aqua button, it’s ( ouontex ) ® v B 2o onwiits la]
very easy to create other buttons— = @Ehigh"ght o
you just have to copy the layer - e buttm — a-
effects. I'll quickly show you how 100 [65] y > @EW n-.
you can make a rectangular aqua v il
button in a few simple steps. ﬂuembass

-

= f gl |

1 In the Layers palette, create the > BB / |
, ] mb“”“‘”‘;1

layers you’ll need for the rectangular m |

= i 0 ® O & @[

button: the base button layer, the )
Copying styles to another layer
highlight layer, and, if you’re planning
on using the embedding effect, an emboss layer, as shown above.
2 To copy the layer effects from the original aqua button to the rectangular button,
hold down Alt (Option on a Mac) and drag the layer style icon from the original
button layer over to its corresponding rectangular button layer, as shown in the

image above.

3 Change the fill of the highlight — =]
layer 0 0% TR e __simr ] |

4 Add the button text and repeat o) 1SS .
step 2 to copy the drop shadow Alls ﬂihighugm ol
style we used for the original — | o ol
text. 100% |5 / M = @Ebwm oF

¥ 1 rounded rectangular

That’s it! Your rectangular aqua

. (] E emboss [ g

1 _g@\! highlight
B Ee—

button is ready to be used, and should applied to
button layer —ww_|

=
Layer style e
%

look like the one on the page opposite.

=]

Button layer with styles applied



http://www.sitepoint.com/launch/650367/

Creating Buttons 77

T layers thepmslsNPaths ™. &
A aquabuttont psd ... | J[E)EF| | roma [+ |Opacity: | 100 [+ |
lock: L 7+ @ Fill:

[ R -
=
& 9 E highlight LI
T
[l
100% [ 5] & WE button L0
/ [® v @ rounded rectangular 1
=
. [ . ] E embass 9
Layer style applied
highlight layer i 5 ™
to highlight laye F,)-—
|
& @E button [ I

[v.

== §. 0 ®© 2 & 3]

Highlight layer with styles applied

Layers 2l > Y
A aquabuttont psd . (= [EJEF| [ vorma [ Jomarity:| 100%]» |
M | Lock: O] 7+ @& Fil: | 1000 [» |

Guuenend) | | = r o weme g
3 ® v [ rounded rectangular
|
o) |- BB~ o
1 T
10, (5] = .W!highught %~
- -

@|
|
L
g
e_
4

@

Dﬂackgvamd 5] ol
= 6.0 . 0 & 3.

The final rectangular button, and the rounded button on which it was based

Making a Transparent Aqua Button

We can also make our aqua buttons see-through, like the one

Transparent aqua button

shown here. In this solution we’re going to begin with a
basic aqua button. If you don’t already have one (and
everyone should!), you can make one by following

steps 1-16 of the “Making an Aqua Button” solution.

Solution A aquabuttonz ped. < O3

1 Place your basic aqua button on top of a faint,

patterned background, as shown here. _

| 100% |

Basic aqua button on top of faint,
striped background
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2 Double-click on the f icon for the layer— [ Gradient Editor =
this will bring up the Layer Style dialog s O -
box. Select the Gradient Overlay style
and click on the Gradient swatch to (e ]
bring up the Gradient Editor.

3 Click once above the gradient bar, in the | e [custom | ——
position shown in this image, ~ Gradient Type:
to create a new opacity stop. smoethness: [ 100 [ [%

Change its opacity to 50%. Y

4 Click OK to exit the Gradient Editor, C
and OK again in the Layer Style dialog [ S:_z:w ﬁ T
box to apply the style. cooe [ ] tocaton|  |% [ pokte

Adding new opacity stop

Changing the fill of the button layer

6 Double-click the
f icon to open the
Layer Style dialog box,
and select the Drop
Shadow style. Choose
a bright aqua color for
the shadow (#90c9e7)
and increase the
Distance and Size
slightly. Change the
Opacity to 40%, as
illustrated at right.

even more polished.

i)
| Layers channels Wpaths S )

; | Marmal [w|opacity: | 1o0% (> |

Waquabuttonz.psd... OB | o 0 ffow 5] 5 Set the fill of the button layer
INLIEEETIIE N I to 0%, as shown at left. The

Caumnid | o7 gmunas

s W iBnidhigt 9 background will show through.

— El button text @ .

100% [ 5] - That’s looking pretty good! But,
HE Layer 2
[y - A as always, there are a couple of
[ S o060 s 5[ things we can do to make it look

Layer Style %)
= #09c0e7
S Ditest i
— Structure
Blending Options: Custom .
——— Blend Mode: | Multiply v
Dﬂ-‘lﬂ* AR Gy IW_°fD New Style...
Cinner Shadow 3 s « =
review

Cuter Glow
EInner Glow
[CBevel and Emboss
[ Contour
[ Texture
[Csatin
[ Color Owerlay
Gradient Overlay
[JPattern Overlay
CStroke

Angle: @ (90 |° [use Globd Light

Distance: —————— I7 P «
Spread: 3| 7;%

Seet [prﬁ

a

— Quality

Cortour: m [ anti-aliased

Mose: > |0 |%

[ Laver knocks Out Drop Shadow

Adding a drop shadow
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7 Next, select the Stroke style. Add a dark blue (#0d487b) 1px stroke, with about
75% opacity, as shown below.

Outer Glow
[ Irner Glow
[CIBevel and Ermboss
[ Cortour
O Texture
[C5atin
[CColor Overlay
Gradient Overlay
[CIPattern Cvetlay

| IStroke.

Layer Style &
Styles Foe
— Structure
Elending Options: Custom B |
Sger 3 |

[F1Drop Shadow =

Mew Style, .
Position: | Outside —
Inner Shadow S
a Preview

Blend Mode: | Mormal e

Opacity:

Color: J—— #0d487b

a

Adding a stroke

8 Finally, select the Inner Shadow style. Change the shadow color to a blue that’s

slightly darker than the one we used in the original gradient button. Lower the

Opacity to 50%, and change the Distance to about 70px (or whatever suits the size

of your button), as shown below.

Stroke

Layer Style <]
= #0d52b2
Styles Inner Shadow 7
— Structure
Elending Options; Custom _. ‘
: i v
EI0rop Shadow Blend Mode: | Multiply S’W* S——
— T Opacity: | Y __—
[“Inner Shadow L
. S Previgw
[l Outer Glow Angle: @ 90 |° [#]use Global Light
[ Inner Glow S —_—
istance:
CBevel and Emboss = u
[ Contour it
[ Texture Stee: |
[Isatin ity
CIColor Cwerlay
Gradient Overlay St
[CIPattern Overlay Hoise:

Adding an inner shadow

9 Click OK to apply these new styles. And—as you can see below—we’ve got our

final transparent aqua button! Swish, very swish!

Counes 3

See-through aqua button

79
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Making a Plastic Button

In this solution, we’ll be using Photoshop magic to turn our e —

friend, the basic gradient button, into a plastic button like

the one shown here. Plastic button

Solution

1 Start with a rounded rectangle Wrmraon | Mo - E%
gradient button that has a radius of l:::?; P .Mopact;:%‘z_l }
5px. You can change the radius in : = B i Tbutton &~ |
the Rounded Rectangle options bar. |~ QmW
Use the color stops shown here in ® [ serigrouns a
your gradient overlay layer style. = 9.0 60§ 3
If you're unsure of how to do this, @__ @|
look at the solution for “Making a g A A
Gradient Button.” I've made my T T !

#71ae07 #baf940 #ebfebs

button green, but you can use
different colors for yours if you like Green rounded rectangle gradient button

Just choose a darker shade of your color for the color patch on the far right, a very
light shade for the color patch on the far left, and a bright shade for the patch in
between, as shown above.

2 Add a dark green, 1px stroke layer style to your button, as shown below.

Layer Style x|
Stes Eitns
— Structure
Elending Options: Default ) I
Spet - 4 px
[1Drop Shadow | & | oo
CInner Shadow Position: | Outside . LRSS
7 .
[Clouter Glow Blend Mode: | Mormal [FPreview
ClInner Glow Cpacity: 100 %
[1Bevel and Emboss D
Dlcortour coor |
[ Texture Coior: [lE—— #35760d
[Csatin
[ Color Overlay
Gradient Crverlay
[Pattern Overlay
[7Istroke

Adding a stroke to the button
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3 Add an outer glow using a bright version of the button color, as shown below.

Layer Style B
s - Outer Glow
— Structure
Blending Options: Default A = |
; __.v
[JDrop Shadow Sl eEal homa : : .
Opacity: —————1 | _New yle...
CInner Shadow 1 = -
 Zlouts Molser > 0 |% Preview
e G © RO
[lBevel and Emboss D
 Hements #al1f43f
[ Cortour 2
[ Texture Techrigue:
: 1
[lsatin Spreach 3 D %
[ iColor Cverlay R e EDX
[Z] Gradient Overlay  Quality
[CPattern Overlay
[ Stroke Contour: |]Z| [ ant-alased
Range: - a3 (=0 |%
ey 0 |%

Adding an outer glow

4 Select the button layer in the it b
. . = | v Duplicate Layer. ..
Layers palette and duplicate it i
using Control-] (Command-J on e
‘5 - W:::‘Vtﬂ Rasterize Layer

S Effects £n Mask
‘@ 0Outer (  Disable Yactor Mask

a Mac). Right-click (hold Control

. 0% [ 5]  Gradier Creste Cipping Mask
and click) on the new layer and @ stoke
N W= i
select Clear Layer Style from the = 0.0 s Loy
. Copy Layer Style
menu that appears, as shown at right. part Layer e
(=]} e Vikle
By plasticbutton.... ... | Layers “Ghannels Raths ™ ) zatfenvxm‘:ge
| Mormal ~|Opacity: [ 503 [+
Lock: [ &+ @ Fill:| 100% | » .
— = Clearing the layer style
[ mgm = R g the fayer sty
| ey o
100 (5] . ST 4
' Outer Glow
® Gradient Overlay |
& Stroke |V
= 9 0 © 0 o 3|

Changing the color of the shape layer

5 Change the Opacity of this layer to 50%, and double-click on its color patch to
open the Color Picker. Set the color of the shape to white, as shown above.

6 Now, click on the vector shape for the N
same layer in the Layers palette. Using
the Direct Selection Tool (A), click on the N "y
bottom line of the rounded rectangle and )
drag it up a little bit, as shown at right. Editing the vector shape

You might need to zoom in for this.
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the bottom-left anchor point so that you can see
the handlebars of the point (zoom in if you need
to). Click on the bottom handlebar, hold down
Shift, and drag the handle up to curve

the corner.

your shape should

5

Selecting multiple points for editing.

10

this is our highlight. Fine-tune the movement

Still using the Direct Selection Tool (A4), click on

Repeat step 7 with the bottom-right point. The sides of

Hold down S$hift and drag the selected points

up to make a thin strip, as shown at right—

LVWJ

Curving the corner

now look like those shown at right.

9 With the Direct Selection
Tool (A), click and drag the

mouse to make a selection

Shape after modifications

that captures all of the
bottom points, as shown in
the image to the left.

using the up and down arrow keys if you

need to.
11

Making the highlight strip

Select the highlight layer in the Layers palette and duplicate it using Ctrl-J

(Command-J). Select Edit > Transform > Flip Vertical to flip the duplicated layer.

12

at right.
13

the button shape layer and name it
middle highlight. Change the

Use the Move Tool (V) to move the
flipped highlight to the bottom of

the rectangular button, as shown

We’re almost there! Now duplicate

m— =]
A plasticbutton.... B | R v e o)
|Nurrnal MODEEIWI 100% | +
S ® | [ ] §E==bottom highight '~
[®| [] @B top highight }
100% | = | B # == huttan @~
® Effects = |
@ Outer Glow
= Gradient Overla [w
== 0. ® O & @[

Adding bottom highlight

color of the shape to white.

Apteticbuton =06 [T mmesmme . 14 Select the bottom anchor points of
el lnaopecinn] 25 the middle highlight shape and move
4 Lock: ] & <+ & Fill:| 1009 | » L.
AT | [®] O e s ottombigigt. them up to the center of the original
P bl g E %:;zﬁ? h?hf:]%_\ 3 button shape. Change the opacity of
O =L this layer to 25%, as illustrated in
@ Effects
= b0 65 355 fﬂ the image on the left.

Modifying the third

highlight shape
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15 Add a text layer immediately on top of the original button

- plastic bulton

The completed plastic button

shape (beneath the three highlight layers) and type your
text. If you like, add a drop shadow for an added three-

dimensional effect, as I've done for the completed button at right.

Making a Glass Button

In this solution, we’re going to create an eye-popping glass

button that’s particularly effective when it’s overlaid on
photographs and non-solid backgrounds.
Example of glassy button

Solution

1 Start with a vector button of any shape in a color that blends in with your
background. Here, I'm using a pink that I color-picked from the sunset image
onto which I'm going to place my button. Set the fill for the button layer to 0%.
Open the Layer Style dialog box by clicking on the Add a layer style button at the
bottom of the Layers palette and selecting Bevel and Emboss... from the menu that
appears. Apply the settings used here, which are illustrated in the dialog below:

B Style: Inner Bevel “Layer style B
B Technique: Chisel Hard Styles B e o]
Blending Options: Custam Style: [ 1rmer Bevel __C |
B Depth: 800% or larger = oo i) =
i Technique: | chicel Hard [v
(depending on the SI““*’ - Caphi 3ol % [preview
Quter Glow
. Direction: (Up  (O)Down
size of your button) Dlinner slow Se 3 [ | a
. . [Z]Bevel and Emboss Sofen: ——— 33— [7 |px
B Direction: Up R

— Shading
[ Testure Angle:

B Size: 13px (You may

need to adjust this

[[] Gradiant Crwerlay

.
[ satin [#]Use Global Light
e F

[ Calar Owerlay Albitude:

Gloss Contour: |]E| [l anti-aliased

later.) Clpstiem Ovarlay -

B Soften: 7px S thlghc;:r:v El";%

B Angle: -65° Shdv;:l ?;%

W Altitude: 65°

Bevel and Emboss settings for the glass button

B Gloss Contour: Rolling slope-descending (Set this by clicking on the drop-
down arrow next to the contour shape and choosing the Rolling slope-
descending option, as depicted overleaf.)

B Highlight Mode: White, 75%

B Shadow Mode: Dark gray, 75%
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Layer Style m
Styles — Bevel and Emboss
- Structure
Blending Cptions: Custamn
[1Drop Shadow: Style: | Inner Bevel ™
[Clinner Shaclow Terhrique: | Chisel Hard  |w Mews Style...
Clauter Glow Depth: —— 3~ @50 [“IPreview
Clinner Glow Direction
[v1Bevel and Embc Size: 4
A A O e A
[ Contaur Saften:
[ Texture o
— Shadin
[Isatin a9 )
[l Calor Ovarlay Angle: |65
[ Gradient Crverlay _USE Global Light
Altitude: |es |°
[CIPattern Ovetlay |
[CIStroke Gloss Contour: m [ anti-aliased
]
Yo
o

Setting Gloss Contour

Your button should be looking like the one shown below.

After applying a Bevel and Emboss effect

2 In the Layer Style dialog box, click Tayer Style B
on the Contour style under Bevel Stles Fiois
. . Blending Options: Custom
and Emboss to select it. Click on the o contour: [ -] DAnti-a!ia;i _‘
oy . Inner Shadow Bange: ———— /100 |% .
thumbnail image of the contour to S — ke
. . CInner Glow C Edi
bring up the Contour editor, ShOWnD | | erel st Esboss g 4
. [lontaur Preset: | Custam | l] ok
at rlght‘ [ Texture. [~ Mapping
3  Select and move the bottom-left Ei;t; —
point of the contour until it’s et oy =
. . i CIPattam Cverlay
positioned just above the first Distroke
horizontal grid marker. Then, click L
on the contour line to add another Tnput: %
Output: Y%
point and drag it to form a curve.

Changing the contour curve
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The image at right shows our button after

the contour effect has been applied.

After applying the Contour effect

4 Not bad, huh? Now, select the Satin [iayer sty =)
layer style and apply the settings Styles Ei
Blending Options: Custom T
shown here: e Bendvoce: | overey || Il i
O p e Opacity:
B Blend Mode: Overlay; black e = Drreview
Couter Glow Angle: | 196 |2
B Opacity: 30-40% LlInnes Bl o e
p y [#Bevel and Emboss Q\stan.te. |f17|p>€ ‘
. Angle: 1260 [#] Contour Sieer 3 !@JDX
) [ anti-aliased
. [ Texture Contour: 2
B Distance: 4px (You may need to Wik
i
. . [ Color Overlay
adjust this later.) = m
B Size: 10px (You may need to — Pattem Gvetay "
[CIStroke s
adjust this later.) |

B Contour: Cone-inverted Applying the Satin layer style

5 Select the Drop Shadow layer style. Change the Distance to 4px, the Size to 10px,
and the Opacity to 50%, as shown in the example below.

E’ayiar' §iyle m
styles Flddlasy
— Structure
Blending Options: Custom
F S Eradow Blend Maode: | Multiply -
£ S S o Hew Stylen,
CInner Shadow: BRI s ‘Sl;! 3 =
,,,,, - review
Dl Outer Glow Angle: ®1 120 |° [Juse Gobal Light
[CInner Glaowr T
Distance: 33— ¥
Bevel and Embass = 4_”: ‘
read: 3 |
[ Contar gie E_D_I%
O Texture Slee: 33— |10 |px
[7]5atin Rty
O Calor Overlay
ClGradient Overlay G I]] [ anti-gliased
[JPattern Cwverlay Moise: 3 ‘ i%
[15troke —
[“]Layer Knacks Out Drop Shadow

Applying a drop shadow

. , . o
At this stage, our button’s looking AT | [ e
quite glassy, as can be seen in the [ Nornal [sejOpecity 1007 ]
lock: (] 4 @ Fill:
ima . e
ge at right O N =" s
= Effects
o |8 '® Drop Shadow
= N @ Pevel and Emboss H
@ Satin
& ! background v
= 6.0 0 0 & 3]

Satin and Drop Shadow layers applied
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6 All we need to do now is add a simple text layer with a slight

drop-shadow! Your completed button should look like the

image to the right.

Completed glassy button

You can easily copy this layer style to other shape
layers. When you do, remember to set the new
layer fill to 0%. Experiment with the layer effects
to change the look of your button. The images Glassy button style applied to different shapes

at right show variations of my glass button.

Bevel and emboss shadow set to 20% opacity

Making a Pearl Button

Here’s a solution that uses real magic ... well, almost!
[* pearl button ’
We’re going to take the glassy button we created in
“Making a Glass Button” and turn it into a pearl button! Example of a pearl button
Solution
1 Start with the glassy button you created g Corors NG = ELE];
in the solution titled “Making a Glass - ] liGEd oo ]
 pearlbutton.ps... |~ [0 m Lock: L] 4 @ Fil:| 1005 > |
Button.” Change the fill of the button - B, ® [] §ETshape1.. @~
. ffects
layer to 100%, as shown at right, and ) QESE)rtOpW
use a very light, “pearly” color for the :Ej;i' ol Emboss
shape. I've used #fae1f9 for my pink, He= - a4
= § 0 ©. 0 & 9]
pearly button.
Changing the fill color
2 Enhance the three-dimensional Layer Style x|
effect of the button by adding a LT 1;3:::: T
slight inner glow. Double-click on e Cpriy: -3 = |

hosei [0 %

the f icon for the layer to bring up o] el _—mmn

M

— Elements

the Layer Style dialog box, shown at b P

Satih Source: Ocenter - ©Edge

right. Select Inner Glow and change

CIColor Overlay Choe:——————— [0 %
Size: 10
the Blend Mode to Normal and the T il U
N . . Cistroke e
Opacity to 10%. Increase the Size if contows | ] Dlarirstac
Range: T et |5EI7}%
you need to. e [o

Adding an Inner Glow effect
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3 We’ll also make the drop shadow a bit more subtle. Select Drop Shadow and

decrease the shadow size to 3px or 4px.
. pearl button ’

Completed pearl button

4 Finally, add your text layer. Here we see our final button—

all done!

Making Angled Tab Buttons

In this solution, I'll show you how to use vector graphic tools to create the angled tab

buttons illustrated below.

Examples of angled tab buttons

Solution
Angled Tab

1 Start with a rectangular vector shape in a color of your choice. I've used a light

blue in the image below.

2
(W anglediab psd . = i | [ Lerers “hannesNEatha S0 )

|| Mormal [ [Opacity: | 100% > |
Lock: O & 4 @ Fill:| 1002 [ > |

N | e

1™ |\ Barkaround a

100% | @

= §.0 ®© 0 & 7|

Starting with a rectangular button

2 Using the Direct Selection Tool (A), select the top left-hand _
anchor point of the rectangle. Hold down the Shift key and
move the point to the right by pressing the right arrow once  Moving the anchor point
or twice. Your image should look something like the one at
right. Release the Shift key and use the arrow keys to fine-tune the point. We’ll go
“old school” here and count the number of times we press the arrow key so that
we know how far to move the point on the right-hand side when we get to it.

3 Repeat step 2 for the top, right-hand anchor point.

That’s it—believe it or not, our angled tab button is complete! If you don’t believe

me, look at the finished result below.

Completed angle button
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Cut-corner Tab

1 This time, we’ll make a tab button with a cut (& QE:M' _ ’
corner. Again, start with a rectangular vector A gzﬁdt’*g"h“pﬂ“ I
shape. Select the Add Anchor Point Tool—you’ll e T
find this in the flyout menu of the Pen Tool (P), Selecting the Add Anchor Point Tool

shown at right.
2 Add an anchor point to the side of the button as I've done in the example below

(you might need to zoom in).

Adding a point to the button

3 Choose the Convert Point Tool, which is also in the (~) 9 pertel iy g
flyout menu of the Pen Tool (P). { #ckd Anchar Peint Too

@- Delete Anchor Point Tool

LI o Convert Point Tool
I~

&3

Selecting the Convert Point Tool

4 Click once on the new anchor point to get rid of the direction handlebars, as

shown below.

I

Converting the anchor point

5 Using the Direct Selection Tool (A), click on the top corner anchor point and
use the arrow keys to move the anchor point across to form a “cut corner”, as

illustrated below.

_
Moving the anchor point Completed cut-corner tab

6 If you like, repeat the effect on the other side; otherwise, take a moment to marvel

at our cut-corner tab, shown above and to the right.
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Making a Rounded Tab Button

The basic rounded rectangle button is very versatile.

Here, we’re going to convert it into the popular rounded
tab button like the one shown at right.
Rounded tab button

Solution
1 Start with a rounded rectangle vector shape, as shown below.

— Gt
E roundedtab.ps... |= |0 m [ Layers Ghannels %Paths % o)
| Marmal [ |Opacity: | 1005 [» |

O D) P
W=l ="

& — Barkgrousd a

100% | 5]

= 6.0 ® 2 5 §

Rounded rectangle shape

2 Select the Convert Point Tool, which is in the flyout menu for the Pen Tool (P).
Click once on each of the two anchor points, as shown below, to convert them

from curve points to angle points.

e~ e

Converting the anchor points

3 Use the Direct Selection Tool (A) to make a selection
0

around the two bottom-most anchor points on the

shape. To indicate that they have been selected, the _ _
Selecting the bottom two anchor points

points will turn from white squares to filled squares,

as shown at right. (ﬁ

4 Delete the anchor points by pressing Backspace or
Delete on the keyboard. Your image should now Deleting the two points

resemble the one shown at right.

5 With the Pen Tool (P), click first on the bottom anchor point m
on the left-hand side, and then on the point on the g
right-hand side, as shown at right. This will draw a line Closing the shape

connecting the two points and complete the shape, which is shown below.

Completed rounded tab button
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Making a File Folder Tab Button

In this solution, you’ll learn how to create a nice file folder tab, shaped much like

those real folder tabs used in filing cabinets. Remember those old-fashioned things?

Example of a file folder tab button

Solution

1 Using the Pen Tool (P), click once to add an anchor point 14
to your Photoshop document (step 1 in the image at right.) 21

2 Position the cursor over the anchor point. Hold down
Shift and Alt (Shift and Option on a Mac), click on the 3 Zaﬁ
point, and drag the mouse towards the right to create a 4 u/‘“—”@\
single horizontal handlebar (step 2 at right). 5 /“—“_\:

3 Position the cursor as shown in step 3 at right. 6
Click and drag the mouse towards the right to add = iz
another anchor point. The line connecting the two 7 5@
points should display a nice curve, thanks to the )
positions of our control handles. Step-by-step file folder tab

4 Holding down Shift, click and drag the mouse to the
right of the last point we made in order to create -
another anchor point with horizontal control handles.

Press Shift to ensure that the two points are aligned completec fll tab button
horizontally (step 4 at right).

5 Move the cursor a bit lower and to the right so that it’s aligned horizontally with
our first anchor point (step 5). Click to add another anchor point and drag the
handlebars out to the right.

6 Bring the cursor back over the last point we made. Hold down Alt (Option) and
click to remove the right handlebar (step 6).

7 Bring the cursor back to our very first point and click on it to complete the shape

(see step 7 at right and the graphic below it).
Don’t worry if your alignment’s not perfect—you can use the Direct Selection

Tool (A) to select individual points, and the arrow keys to fine-tune them.
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Summary

In this chapter, I showed you how to make all sorts of buttons! Beyond the obvious

navigation buttons, the techniques you’ve learned here will allow you to make nifty
bullet graphics and fancy title bars. For example, you could apply the plastic button
effect to a longer rectangle that forms part of your interface, or use it as a bar for text
links. You could also use the shiny metal button effect to create shiny metal bullets;

you’ve got a gazillion options!

The experience you’ve gained with layer styles and vector shapes in this chapter will

be invaluable to you later, when you’re creating full web site comps. There’s a lot

more fun to be had in the next chapter—let’s bring on those backgrounds!
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What's Next?

If you’ve enjoyed this chapter from The Photoshop Anthology, why not order

yourself a copy?

SitePoint’s first full color book, The Photoshop Anthology: 101 Web Design Tips,
Tricks & Techniques provides you with over 100 tried and tested real-world
Photoshop solutions for you to use on your projects. If you’ve ever been stuck for
inspiration, or have puzzled over just how to create that shiny “Aqua” style button or
that seamlessly tiling background image you saw on a web site recently, you need a

copy of this book.

Author Corrie Haffly has drawn on her extensive Photoshop experience to show you
how to create a multitude of web graphics, ranging from buttons to backgrounds

to other user interface elements. Corrie also covers ways to greatly improve your
workflow and make working with Photoshop more efficient through batch processing

and the automation of repetitive tasks.

Following the same step-by-step, problem-and-solution format used in other
SitePoint Anthology books, this book is packed with best-practice, innovative and

visually stunning techniques to produce amazing graphics for your web sites.

The book’s full color layout and larger than normal size (8" x 10”’) were especially

designed to help show off the techniques demonstrated in the book.

The Photoshop Anthology: 101 Web Design Tips, Tricks & Techniques also includes
download access to all of the Photoshop (PSD) files used in the book—that’s over

50MB of files—so you can use them right away in your projects.
In the rest of the book, you’ll learn how to:

e Master the basics: image sizing, layers, vector shapes, transparency, and more.

e Create a multitude of different buttons: aqua-style, metallic, glassy, and more.

e Create seamless tiling backgrounds: rice paper, brushed metal, granite, and more.

e Work with text: style it, create special effects, wrap it around 3D objects, and more.
e Touch up photographs, match colors, and combine different images.

¢ Use eye-catching special effects.

e Isolate objects from images.

Order the print version of this book to get all 286 pages!
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* Make graphics for CSS rollover buttons.

* Design an entire web site and easily switch between different versions.

e Optimize graphics for web use.

e Work smarter: automate your workflow with batch commands and actions.
e Create animated GIFs.

¢ And lots more ...

On top of that, order direct from sitepoint.com and you’ll receive a free Hexadecimal

Color Reference Chart (while stocks last!).

Order now and get it delivered to your doorstep!
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